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Lesson 9 — Analyze Financial Data Lesson Objectives

Lesson Objectives

® Discuss some of the tools in QuickBooks for analyzing financial data: QuickReports, preset
reports and graphs

® Create a QuickReport

® Add acolumnto areport

® Learn how to move a column in a report

® Learn about the types of preset reports QuickBooks offers
@ Practice creating reports and viewing them onscreen

® Customize a report by changing how it looks and the data it covers (filtering)
® Learn how to process reports in batches

@ Save reports as portable document format (PDF) files

® Learn how to export a report to Microsoft Excel®

® Practice filtering reports in Excel

® Learn about the types of graphs QuickBooks offers

® Create and customize several graphs

QuickBooks 2017 Student Guid . 4
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Create QuickReports

Create QuickReports

One of the fastest ways to see a report on your QuickBooks data is to create a QuickReport.
QuickReports are predesigned reports that give you information about the list name you're currently
viewing on screen. Whenever you have a list, register or form displayed, you can click a button to
have QuickBooks create a QuickReport.

@]

o1 Step-by-Step: See What You Owe a Vendor

1. Click Vendor Center on the icon bar.

E Mew Vendor.. ¥

New Transactions *

& Frnt v

Excel ¥

f.'i' Word ¥

i Bil Tracker

Active Vendors hd >
jol
MAME i BALANCE TOT... | ATTACH
ACheung Limited 0.00 =
Bank of Anycity 0.00 '
Bayshore Caldil ... 0.00
Bayshaore Water 0.00
Bruce's Office Ma 0.00
C.U. Electric 750.00
Cal Gas & Electric 12268
91.94
TR
City of Bayshore 0.00
City of East Bays... 0.29
City of Middlefield 0.00
Custom Kitchen... 0.00
Daigle Lighting 1,581.00
Davis Business ... 0.00
Dianne’s Auto Sh... 0.00
East Bayshore A. 0.00
East Bayshore T. 0.00

Vendor Information

Company Name

Main Phone  650-555-0912

# NOTE

Mo note available

Full Name
REPORTS FOR THIS VENDOR
Account No.  08-4567-432
Terms  Net15 QuickReport
Billed From  Cal0il Company Open Balance
PO Box 628
Middlefield CA 94452
Order Checks
Map | Directions
Transactions Contacts ToDo's Motes Sent Email
sHow  |All Transa.. » | Furerey Al « | pate |This FiscalYear ~ | 1/01/2021-12/31/2021
TYFE I NUM I DATE ¥ i ACCOUNT I AMOUNT
Check 479 12/02/2021 10100 - Checking 13580 4
Check 457 11152021 10100 - Checking -48.28 l
Check 422 101512021 10100 - Checking -G,534.28
Check 355 071512021 10100 - Checking -4,674.89
Check 336 06M15/2021 10100 - Checking -9,164.00
v
Manage Transactions | v Run Reports b

QuickBooks 2017 Student Guide
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Lesson 9 — Analyze Financial Data Create QuickReports

2. Right-click on the vendor name you wish to run a report for and select QuickReport, or click on
the QuickReport hyperlink in the section.

= Vendor QuickReport — 0O %
Customize Report Comment on Report Share Template Memorize Print + E-mail ¥ Excel ~ Hide Header Refresh
[DECEJ This Month-to-date *  From 12/01/2021 B To 121572021 B Sor By Default -
Show | Applied Filters
12:20 PM Rock Castle Construction
1211821 Vendor QuickReport
December 1 - 15, 2021
Type Date Num Memao Account Cir Split Debit Credit
Caldil Company
b Check 12/02/2021 479 10100 - Checking 20800 - Cald... 13580 4
QuickBooks 2017 Student Guide 6
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Lesson 9 — Analyze Financial Data Zoom in on a QuickReport

Zoom in on a QuickReport

All QuickReports contain a summary of individual transactions. To help you better understand the
information presented in reports, QuickBooks lets you trace report data to the individual transaction
level using QuickZoom.

When you position the mouse pointer over a number in a report and see the QuickZoom symbol (a
magnifying glass with a Z in it), you can double-click the number to display the original transaction in
QuickBooks.

@
2! Step-by-Step: See more Detail about a Transaction

1. From any financial report, hold your cursor over the dollar amount/transaction you wish to view
in more detail.

2. When your cursor turns into the QuickZoom icon, double-click your mouse to zoom in. This will
open the transaction.

3. Press Escto close the window.

NOTES

QuickBooks 2017 Student Guid . 7
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Lesson 9 — Analyze Financial Data Customize QuickReports

Customize QuickReports

Each QuickReport window has a button bar at the top of the report for customizing report content
and layout.

Customize Report Comment on Report Share Template Memaorize Print * E-mail * Excel ¥ Hide Header Refresh

[DEICE This Month-to-date * From 12/01/2021 B To 12152021 [ SortBy Default -

@
2! Step-by-Step: Add a Column to a Report

1. Inthe QuickReport window, click Customize Report.

2. Inthe Columns list, select the additional columns you would like to add to the report (in this
example, we marked the Trans # column).

Modify Report: Vendor QuickReport

Display Filters Header/Footer Fonts & Numbers

REPORT DATE RANGE

Dates This Month-to-date *  From the first day of the current month through today

From |[12/01/2021 B To 12152021 A

COLUMNS
Search Columns Sortpy Default -
S @ Ascending order 2%
- A Sortin ] =
< | (left margin) 1 Descending order i
+ Trans # "
< Type
EnterediLast Modified
Last modified by
+ Date
< Mum
Put a check mark next to each column
v that you want to appearin the report.

Revert

QuickBooks 2017 Student Guid . 8
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Lesson 9 — Analyze Financial Data Customize QuickReports

3. Click OKto accept the change.

= Vendor QuickReport - O %

Customize Report Comment on Report Share Template Memorize Print + E-mail = Excel - Hide Header Refresh

[nENCI- 3 This Month-to-date *  From 12/01/2021 B To 12152021 B Sort By Default -

Show | Applied Filters

12:25 PM Rock Castle Construction

1215121 Vendor QuickReport
December 1 - 15, 2021

Type Date Num Memo Account Clr Split Debit Credit

Calil Company
» 103% Check 12/02/2021 479 10100 - Checking 20600 - CalO... 135.80 4

Notice the additional column(s) in your report.

@
2! Step-by-Step: Move a Report Column

1. Position your mouse pointer over the column you wish to move (the mouse becomes a hand).

2. Hold down the left mouse button and drag the column header/name to the position you would
prefer. When a red arrow appears, release your mouse button.

QuickBooks 2017 Student Guid . 9
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0

1.

NOTES

]

Step-by-Step: Change Information in the Report Heading

Customize QuickReports

In the report window, click Customize Report then click the Header/Footer tab.

Modify Report: Vendor QuickReport x

Display

Filters

SHOW HEADER INFORMATION

Header/Footer

@ Company Name
| Report Title

| Subtitle

v Date Prepared

| Time Prepared

+| Page Mumber

+| Extra Footer Line

Rock Castle Construction

Vendor CluickReport

December 1- 15, 2021

12/31/01

+| Print header on pages after first page

SHOW FOOTER INFORMATICN

Page 1

Fonts & Numbers
PAGE LAYOUT

Alignment
Standard

[ate "
Titl
Basziz e

lan!Eup Branriplinn

Extra Line

Time Company

Subtitle

Hay 4393

[T
11.55
[T

50752

Fage

+| Print footer on first page

Revert

Help

On the Header/Footer tab you can change the company name, report title, subtitle, and date
and time prepared. You can also specify whether to print the header on all pages or just the first

page. The Header/Footer tab is the same for all QuickBooks reports.

Highlight the text in the Report Title field and replace it with the title you would like.

Click OK to close the Modify Report window.

Close the report.

E

IMPORTANT: To save this report for future use, click the Memorize button on the report tool bar before
closing the report. This allows you to save the custom settings and run the report at a later date from the
Reports drop-down menu.

QuickBooks 2017 Student Guide
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Lesson 9 — Analyze Financial Data

Use the Report Center

Use the Report Center

A good way to learn about the reports available in QuickBooks — and how to work with them — is
the Report Center.

The Report Center contains a description and example of each QuickBooks report. You can click the
icons at the top right corner of the Report Center to select the display format you prefer.

@]

2!  Step-by-Step: Learn More about Reports

1. Click Reports on the icon bar (or under the Reports menu) then click Report Center.

2. Use the blue view icons in the top right corner to customize your view.

Standard

Company & Financial

Customers & Receiva...
Sales

Jobs, Time & Mileage
Vendors & Payables
Purchases

Inventory

Employees & Payroll
Banking

Accountant & Taxes
Budgets & Forecasts

List

Memorized

Favorites Recent

Company & Financial

Profit & Loss (income statement)

Profit & Loss Standard

Contributed

Report Center

Profit & Loss Detail

Search

L]

Profit & Loss YTD Comparison

Prant & Lass Stangard Company & Francat
Ortinary IncomeExperce
e
A0 o B
TS0 - Ryt Incame wm
Tow ncame: 306
o G s
50400 - st of Gock Sl 2ouer
51000 - 15 Expenaes e
oo b
Gz Pt e
5200 - separs s
50300 Tk ani Moy mum
Rl s
et Ontrary rcnme ]
s IncomefEspense
Incama
0400 Dt rczme )
otal axner )
et omer ncema )
1958056

Profit & Loss Detsu Company & Francal

3

S ket 08D S,
S gt 008 WL Do

i
[
4
H

k

i

#

:
Bebk e 2ke

i
E
E bEbbE: ske
E B
Bophbbke rheee h;

Proft & Lasz YT Comparian. Company & Francal
lebey  eben  iCu SO
Ootesry bcarSesnss
Grraneren SEI¥  RELM DD mny
Towd b s s wemm mns
ot of Goks Skt
sttt A5 | LB ia0s e
T €565 LAl A s mew
oo k. SN mmAE  AMAS sama
=
Tass me s ow us
M me Lo omms
T v S e ST Y
NGy eGSR i s S
Ot
Cnu e
=y 1w W omm e
Towd G bz 1 W mw s
et ey Lo mE s
Nt b ARG 0w pARE

=

B

Contractor Dates: ~ This Montn-to-date - Dates:  This Fiscal Year-fo-date - Dates:  This Montn-to-date ~

Mfg & Wholesale 120121 121521 101721 121521 1200121 1211521

Professional Services 0 ﬂ O 0 0 ﬂ O o 0 ﬂ O o

Retail

Nonprofit {
GRID VIEW

QuickBooks 2017 Student Guide
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Lesson 9 — Analyze Financial Data

Report Center - O %

Sales

Jobs, Time & Mileage
Vendors & Payables
Purchases

Inventory
Employees & Payroll
Banking

Accountant & Taxes
Budgets & Forecasts
List

Contractor

Mfg & Wholesale

Professional Services

Standard Memorized

Company & Finan

Customers & Receiva...

Favorites Recent Contributed

Company & Financial
Profit & Loss (income statement)

Profit & Loss Standard

How much money did my company make or lose over a specific period of time?

©Q B @ @ | Dates ThisMonthtodate » 120121 121821
Profit & Loss Detail

‘What are the year-to-date transactions (and totals) for each income and expense account, so | can determine whiat contributed to my company's
net profit?

0 n @ 0 | Dates: This Fiscal Year-to-date = 101121 121521

Profit & Loss YTD Comparison

How do my income and expenses for a recent period of time compare to the entire fiscal year to date?

Q E @ @ | paes ThisMonthiodate v 10t 1201524

Profit & Loss Prev Year Comparison

Use the Report Center

Search

Customers & Receiva
Sales

Jobs, Time & Mileage
Vendors & Payables
Purchases

Inventory

Employees & Payroll
Banking

Accountant & Taxes
Budgets & Forecasts
List

Contractor

Mfg & Wholesale
Professional Services
Retail

Nonprofit

Profit & Loss Standard

much money did my company make or lose over a specific period of time?

Profit & Loss Standard Company & Financial
Ordinary Tncome/Ppense
Income
40100 * Corstruction Income 39,324.16
39,324.16

2,043.67
1667246

822113
20,603.03

175.00
810.00

985.00
1961803

4353
4353

43.53
19,661.56

-
Dates: This Month-fo-date ~ 12/0121  12/15/121 g o
Run Fave Help

CAROUSEL VIEW

Retail Is my company making more money now than for the same period a year ago?
Nonprofit

Standard Memorized Favorites Search
Company & Financial

3. Click the Contributed tab to open Contributed Reports, an Intuit web page where you can
search, review, download and import additional reports. Review the information then close the

window.

QuickBooks 2017 Student Guide
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Lesson 9 — Analyze Financial Data Create a Balance Sheet Previous Year Comparison Report

Create a Balance Sheet Previous Year
Comparison Report

The balance sheet comparison report compares the current year against the previous year in both
dollar amount and percentage.

@
2! Step-by-Step: Create a Balance Sheet Previous Year Comparison Report

1. Inthe Report Center, click on the Standard tab and choose Company & Financial, scroll down
and choose Balance Sheet Prev Year Comparison.

2. Click the Run Reporticon.

Balance Sheet Prev Year Comparison

Customize Report Comment on Report Share Template Memorize Print |+ | E-mail v | Excel v Hide Header Collapse Refresh

[DECIERM This Fiscal Year-to-date =  Asof 12M15/2021 B Show Columns  Total only * Sort By Default -

Show | Applied Filters

12:43 PM Rock Castle Construction
121521 Balance Sheet Prev Year Comparison
Accrual Basis As of December 15, 2021
Dec 15, 21 Dec 15, 20 § Change % Change
T ASSETS

¥ Current Assets

¥ Checking/Savings
10100 - Checking » 49,187.70 4 36,860.57 12,327.13 33.4%
10300 - Savings 17,910.19 15,808.64 2,101.55 13.3%
10400 - Petty Cash 500.00 500.00 0.00 0.0%
Total Checking/Savings 67,587.89 53,169.21 14,428.88 2T A%
¥ Accounts Receivable
11000 - Accounts Receivable 79,880.78 20,841.04 59,039.72 283.3%
Total Accounts Receivable 79,880.76 20,841.04 59,039.72 283.3%
¥ Other Current Assets
12000 - Undeposited Funds 15,440.00 20,252.08 -4,812.08 -23.8%
12100 - Inventory Asset 30,683.38 12,767.04 17,916.34 140.3%
12800 - Employee Advances 832.00 T70.00 52.00 8.1%
13100 - Pre-paid Insurance 4,050.00 5,091.85 -1,041.85 -20.5%
13400 - Retainage Receivable 3,703.02 1,796.72 1,806.30 106.1%
Total Other Current Assets 54,708.40 40,677.69 14,030.71 34.5%
Total Current Assets 202,187.05 114 687.94 87,499.11 76.3%
¥ Fixed Assets
15000 - Furniture and Equipment 34,326.00 22,825.00 11,500.00 50.4% v

Scroll the report window to see more of the report.

QuickBooks 2017 Student Guid . 13
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Lesson 9 — Analyze Financial Data Create a Balance Sheet Previous Year Comparison Report

3. Click the Collapse button in the top right section of the report to see the difference.

The Collapse button hides subaccounts, jobs and subclasses. Amounts are summarized under
the parent account. This button affects both the onscreen and printed report.

4. Click Expand in the top right section of the report (where the Collapse button had been) to
return to the original report display.

5. Close the report.

NOTES

QuickBooks 2017 Student Guid . 14
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Filter Reports

You can customize reports in QuickBooks to highlight just the information you're interested in

getting. In this exercise, you'll customize the balance sheet comparison report and filter it to include
only the transactions you specify.

Report filters let you set custom criteria for the transactions you want included in a report. When you
filter a report, QuickBooks includes only those transactions that match the rules you create.

@
2! Step-by-Step: Filter a Preset Report

1. With the Balance Sheet Prev Year Comparison report displayed, click Customize Report on the
Report button bar.

2. Click the Filters tab.

Modify Report: Balance Sheet Prev Year Comparison

Display Filters Header/Footer Fonts & Mumbers

CHOOSE FILTER CURRENT FILTER CHOICES

Search Filters Account FILTER i BETTO
FILTER Date This Fiscal Year-t...
All accounts A
oo
Aging l Mo
Amount Yes
B-Day Far detail accounts matching
Billing Status SIS -
v

Remove Selected Filter
ACCOUNT FILTER

Choose the types of accounts or a specific account from the

drop-down list. Indicate whether or not you want split detail
to appear in the report (Balance Sheet accounts only).

Tell me more...
Revert

3. Inthe Filter scroll box, choose the filters you want to set your parameters for and set your
specifications.

QuickBooks 2017 Student Guid . 15
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Lesson 9 — Analyze Financial Data Filter Reports

4. Toremove or modify a filter, highlight it in the Current Filter Choices section, and either modify
the filter or click Remove Selected Filter.

5. Click OK.

6. You can review what filters have been applied directly on any particular report by clicking Show
next to Applied Filters in the top left corner of the displayed report. Once you have done that,
you can click on a filter to change it, or click on the X next to the filter to remove it. When printed,
reports with Applied Filters displayed will print the filters on a separate page. You can also click
Hide next to Applied Filters (where the Show button had been) to hide the list of filters.

Balance Sheet Prev Year Comparison

Customize Report Comment on Report Share Template Memorize Print * | E-mail |~ | Excel ~ Hide Header | Collapse Refresh
[aEICER This Fiscal Year-to-date ~ | Asof 12/115/2021 @ Show Columps ~ Total only ~ SortBy Default -
Hide | Applied Filters:| Date: This Fiscal Year-to-date ’ﬂ, ‘
12:44 PM ™ Rock Castle Construction
121824 Balance Sheet Prev Year Comparison
Accrual Basis As of December 15, 2021
Dec 15, 21 Dec 15, 20 § Change % Change
~ ASSETS 4
¥ Current Assets l
¥ Checking/Savings
10100 - Checking » 4918770 4 35,860.57 1232713 33.4%
10300 - Savings 1791019 15,808.64 2,101.55 13.3%
10400 - Petty Cash 500.00 500.00 0.00 0.0%
Total Checking/Savings 67,597.89 53,168.21 14,428.68 27.1%
¥ Accounts Receivable
11000 - Accounts Receivable 79,880.76 20,341.04 59,038.72 283.3%
Total Accounts Receivable 79,880.76 20,841.04 59,038.72 283.3%
¥ Other Current Assets
12000 - Undeposited Funds 15,440.00 20,252.08 -4,812.08 -23.8%
12100 - Inventory Asset 30,683.38 12,767.04 17,916.34 140.3%
12800 - Employee Advances 832.00 T70.00 62.00 8.1%
13100 - Pre-paid Insurance 4,050.00 5,081.85 -1,041.85 -20.5%
13400 - Retainage Receivable 3,703.02 1,796.72 1,806.30 106.1%
Total Other Current Assets 54,708.40 40,677.69 14,030.71 34.5%
Total Current Assets 202,187.05 114,687.94 B7,499.11 76.3%
¥ Fixed Assets
15000 - Furniture and Equipment 34 326.00 22 826.00 11,500.00 50.4% v
NOTES
QuickBooks 2017 Student Guide 16
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Save Reports as PDFs

To keep a record of the information in the report as it exists today, you can save the report in
portable document format (PDF).

@
2! Step-by-Step: Save a Report as a PDF File

1. With the report open, choose Save as PDF from the File menu. (You can also click on Print >
Save as PDF))
2. Navigate to the folder where you want to store the PDF and enter a file name.

3. Click Save.

4. Close the report window.

=  IMPORTANT: if you wish to send the report as a PDF attachment to an email in one step without saving it
as a PDF first, select Email - Send report as PDF. (QuickBooks will not allow you to select the Send
report as PDF option if you are using a sample company.)

NOTES

QuickBooks 2017 Student Guid . 17
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Lesson 9 — Analyze Financial Data Use QuickZoom in a Report

Use QuickZoom in a Report

@
o Step-by-Step: QuickZoom on a Listing in a Report

1. Position the mouse pointer over the listing you wish to view in detail.
2. Double-click the amount.
What you see when you QuickZoom in a report will depend on the type of report displayed:

® If the report shows summary figures (like the Sales by Customer Summary report below) and
you QuickZoom an amount...

Sales by Customer Summary

Customize Report Comment on Report Share Template Memorize Print |+ E-mail ¥  Excel ¥ Hide Header | Collapse Refresh

Dates  This Month-to-date * From 12/01/2021 E To 12M15/2021 B Show Columns Total only * Sort By Default -

Show | Applied Filters

12:56 PM Rock Castle Construction
12115124 Sales by Customer Summary
Accrual Basis December 1 - 15, 2021

Dec1-1521

¥ Abercrombie, Kristy
Remodel Bathroom 3,887.00
Total Abercrombie, Kristy 3,887.00
¥ Allard, Robert

[ 13

Remodel 319.08
Total Allard, Robert 319.05
¥ Baker, Chris
Family Room 1,400.00
Total Baker, Chris 1,400.00
~ Balak, Mike
Utility Shed 140.00
Total Balak, Mike 140.00
¥ Campbell, Heather
Remodel »
Total Campbell, Heather
¥ Cook, Brian
Kitchen 1,528.45
Total Cook, Brian 1,528.45 v
QuickBooks 2017 Student Guide 18
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... QuickBooks displays a detail report that includes the transactions which contribute to that
amount. You can then double-click on an individual transaction in that detail report to

QuickZoom on it.

Sales by Customer Detail

Customize Report Comment on Report Share Template Memorize Print ~ E-mail ~ | Excel - Hide Header Refresh
Dates *  From 120012021 B To 12M15/2021 B8 SortBy Default .
Show | Applied Filters
12:58 PM Rock Castle Construction
1215124 Sales by Customer Detail
Accrual Basis December 1 - 15, 2021
Type Date Hum Memo Name ltem Gty U/ - Sales Price Amount Balance
Campbell, Heather
Remodel
» Invoice 121002021 1082 Floor plans Campbell, Heather... Floor Pla... 20 150.00 3,000.00 4
Invoice 121002021 1082 Installation la... ~ Campbel, Heather... Installati.. 150 50.00 §,000.00 12,000.00
Invoice 121002021 1082 General Labor  Campbell, Heather... Labor 30 50.00 1,500.00 13,500.00
Invoice 121002021 1082 Removal labor  Campbell, Heather... Remova... 10 40.00 400.00 13,900.00
Total Remodel 210 13,900.00 13,900.00
Total Campbel, Heather 210 13,300.00 13,300.00
TOTAL 210 13,900.00 13,900.00

® If you QuickZoom a transaction in a detail report, QuickBooks opens and displays the invoice,
bill or other form for the requested transaction. At this point you can review, delete or edit
the displayed transaction as necessary.

Create Invoices

Main Formatting Send/Ship Reports oA
@ P n E % B Creatc a Copy @) E = Print Later ﬁmm Time/Cosis [ El) create a Baich
Find New Save Delete §BMemorize Mark As Print  Email EmailLaler  Attach | B Apply Credits Receive B Refund/Credit
T T Pending - - File Payments
s TEMP Rock Castle Invoice + > Campbell, Heather:Remodel
Customer i
| nVOICG DATE BILLTS sHip o (SIPTO e &
1211072021 -] Heather Campbell Heather Campbell SUMMARY
P 98342 Sharondale Rd. 98342 Sharondale Rd.
INVOICE -
: Millbrae, GA 94030 Millbrae, CA 94030 Phone 050-555-3423
1092 Email hcampbell@myamail.com
Preferred delivery method None
TERMS DUE DATE Open balance 13,900.00
Net 15 v 121252022 @ Active estimates 0
Sales Orders to be invoiced 0
ITEM i DESCRIPTION { QUANTITY | LM i RATE i AMOUNT TAX
Floor Plans Floor plans 20 150.00 3,000.00 Mon A
Installation Installation labor 150 60.00 9,000.00 Mon l CUSTOMER PAYMENT &
Labor General Labor 30 5000 150000 Mon Your customer can not pay online
Removal Remaoval labor 10 40.00 400.00 Mon Edit customer preferences
v
RECENT TRANSACTION &
“Your customer can't pay this invoice online 4% 5an Tomas v | (775%) 0.00 1210121 Invoice 13,900.00
Turn on TOTAL 13,900.00
CUSTOMER MESSAGE FAYMENTS AFFLIED 0.00
- BALANCE DUE 13,900.00 HOTES ¢
MEMO CUSTOMER | Tax - Save & Close Save & New Revert
NEESES L e e )
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Lesson 9 — Analyze Financial Data Memorize Reports

Memorize Reports

You may want to memorize reports which you customize, filter and run frequently. Memorizing
reports can save you from spending time customizing the same reports over and over again.
Remember, memorizing reports saves your customizations and filters, not the data. As new data is
entered or existing data is changed, running a memorized report will display the refreshed data but
with the same settings (e.g., columns, title, etc.) you saved.

@
9! Step-by-Step: Memorize a Report

1. When you are in a report you would like to memorize, click Memorize from the report tool bar.

ICustomizeReport Comment on Report Share Template IMemori;eI Print * | E-mail « | Excel - Hide Header Collapse Refresh

2. Name the memorized report accordingly.

3. Click the Save in Memorized Report Group checkbox if you would like to assign this report to a
group (you'll see more about memorized report groups in the next section), then choose the
group from the drop-down menu.

Memorize Report

Mame: Sales by Customer Detail

¥ Save in Memorized Report Group: Customers

574

[+ Share this report template with others AELLLIAL
Banking

Customers o
12M5/21

Employees

Accrual Basis Vendars

4. Check the box next to Share this report template with others if you wish to offer this
memorized report (the settings, not the data!) to the entire Intuit community to help others who
may have a need for business information similar to yours in their own QuickBooks company
files.

QuickBooks 2017 Student Guid . 20
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Lesson 9 — Analyze Financial Data Memorize Reports
5. Click OKto memorize the report.

6. Close the report.

NOTES
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Create Memorized Report Groups

In addition to memorizing individual reports to save report settings, you can create memorized
report groups to organize your memorized reports in a way that makes sense for your business and
allows you to process a group of reports all at once.

QuickBooks comes preset with a number of memorized report groups, each already populated with
common reports for each area. You can add your own reports to these groups, modify the groups to
meet your needs and even create your own groups.

@
o0  Step-by-Step: Create a Memorized Report Group

1. Choose Memorized Reports from the Reports menu then choose Memorized Report List.

Memorized Report List

B

REFORT MAME
+ Accountant
+Balance Sheet
«General Ledger
«Journal Entries Entered Today
«Profit & Loss
+Trial Balance
+ Banking
+ Check Detail
+Deposit Detail
+ Company

Memorized Report - Display... Print... Export...

2. Inthe Memorized Report List, click the Memorized Report menu button then choose New
Group.

3. Inthe Name field of the New Memorized Report Group window, type Year End.

4. Click OK.

NOTES
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Print Reports

@
o Step-by-Step: Print a Report

1. With a report open, click the Print button from the tool bar then choose Report.

e s

Settings =~ Margins
Adobe PDF on Documentsy*.pdf - i
(OF p Options... Cancel
1 File: ASCI text file -
Help
Maote: Ta install additional printers orto change port
assignments, use the Windows Control Panel. Preview
ORIENTATION: PAGE RANGE:
@ Portrait @ All
1 Landscape 1 Pages:
From: 1 To: 9999
PAGE BREAKS:
. ) Mumber of copies: | 1
| Smart page breaks (widow/orphan control)
[+ Caollate
[ Page break after each major grouping
[+ Fit report to 1 page(s) wide [ Printin color (color printers anly)
[ Fitreport to 1 page(s) high
2. Click Preview to see how the report will look when you print it.
QuickBooks displays a preview of your report onscreen.
3. Click Print.
4. Close the report.
NOTES
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Process Reports in Groups

]
0

Step-by-Step: Batch Process Reports in a Group

Process Reports in Groups

1. Inthe Memorized Report List, select the report group you would like to print.

2. Click Display.

QuickBooks opens the Process Multiple Reports window. You can use this window to display or

print the selected reports (selected by the checkmark in the far left column next to the reports).
You can also change the date range for reports in this window before you display or print them

by changing the information in the From or To columns.

Process Multiple Reports *®

T Commented Reports

Select Memorized Reports From  Accountant -

Choose the reports to process, then press Display, Print or Email.

! REFCRT ! DATE RANGE ! FROM P TO

Balance Sheet This Fiscal Year-to-date 010142021 121512021 |~

General Ledger This Manth-to-date 1200112021 121512021

» Journal Entries Entered Today Today 12M5/2021 121512021

» Profit&Loss This Month-to-date 12/01/2021 12152021

» Trial Balance This Month-to-date 1200112021 121512021
v

5 report{s) selected m Print Email Cancel Help

3. Selectthe reports you wish to print and click Display to review the information in the reports, or
click Print to print the reports.

If you chose to display the reports, you can print each report individually. Click the Print button from

that report’s tool bar then choose Report.

NOTES
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Process Multiple Miscellaneous Reports

In addition to batch processing a group of reports, you can also batch process various selected
memorized reports that are not all in the same report group.

@
o  Step-by-Step: Batch Process Multiple Miscellaneous Reports

1. From the Reports menu, select Process Multiple Reports.

2. QuickBooks opens the Process Multiple Reports window. Select the memorized reports you want
to process (all reports from all groups are currently listed) by placing a checkmark next to the
desired reports. You can also change the date range for reports in this window before you
display or print them by changing the information in the From or To columns.

Process Multiple Reports X

® Memaorized Reports ) Commented Reports

Select Memorized Reports From | <All Reports= -

Choose the reports to process, then press Display, Print or Email.

REFORT DATE RANGE FROM TO
i Customers:Open Invoices Today 12M15/2021 B 12152021 -] A
i .,m Employees:Payroll ltem Detail This Manth 1210172021 1213102021
Employees:Payroll Liabilities Custom 010142003 113002003
Employees:Payroll Summary This Month-to-date 1210172021 12/15/2021
+ Missing Invoices All
Profit & Loss by Job All
Vendors AP Aging Summary Today 121572021 1211512021
« |Vendors:Unpaid Bills Detail Today 121512021 121512021
Vendors:Vendor Balance Detail All l
Vendors:Vendor Balance Summary All v

4 report(s) selected m Print Email Cancel Help

3. Once the desired reports are selected, choose Display to review the information in the reports
or Print to print the reports.

If you chose to display the reports, you can print each report individually. Clicking the Print button
from that report’s tool bar then choose Report.
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Send a Report to Excel

Occasionally you may want to change a report’s appearance or contents in ways that aren’t available
in QuickBooks, filter report data in ways you cant in QuickBooks, or run “what-if" scenarios on your
QuickBooks data.

You can send reports from QuickBooks to Excel. Since the changes you make in Excel don't affect
your QuickBooks data, you're free to customize reports as needed and even change data to run
"what-if” scenarios.

@
2! Step-by-Step: Send a Report to Excel

1. From the Reports menu, open the report you would like to convert to Excel.

2. On the Report button bar, set the date parameters for your report. You can use the Customize
button to set additional filters and add additional customization.

3. Ifyou clicked on the Customize button in the previous step, after you've specified your
additional parameters, click OK.

4. On the Report button bar, click Excel and Create New Worksheet (or you could select Update
Existing Worksheet if this report with these settings was previously sent to a spreadsheet that
was saved).
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5. Click the Advanced tab to add custom export options.

Advanced Excel Options x

QuickBooks Options:
Keep the following format options from QuickBooks:
¥ Fonts | Space between columns
¥ Colors |+ Row height
Excel Options:
Turn on the following Excel features:
[ AutoFit (set column width to display all data)
|| Freeze panes (keep headers and |abels visible)
|¥| Show Gridlines

|¥| Auto Qutline (allows collapsing / expanding)

[ iAuto Filtering (allows custom data filtering

¥ Include QuickBooks Export Guide worksheet with helpful advice
|| Create backup worksheet during update
Printing options;
Show report header:
@® On printed report only
) On printed report and screen
¥ Repeat row labels on each page

6. Click OK then click Export.

Send a Report to Excel

QuickBooks 2017 Student Guide
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Create an Income and Expense Graph

If you want your business to be profitable, you need to keep an eye on your expenses. The income
and expense graph shows exactly what you're spending and where.

You should be especially concerned with the proportion you're spending on expenses relative to the
income you receive. As a simplistic example, if you're earning only $20,000 in income, you don't
want to spend $30,000 in expenses.

@
2!  Step-by-Step: Create an Income and Expense Graph

1. From the Reports menu, choose Company & Financial then choose Income & Expense Graph.
You will see the top 10 expense categories listed with numerical information next to a key listing
them with their pie chart colors.

N Quicklnsight: Income and Expense Graph
Dates... By Account | By Customer | By Class Next Group Print... Refresh
Income and Expense by Month B Income
January 1 through December 15, 2021 M Expense
%in 1,000
70
60
50
40
30
20
10
Jan 21 Mar 21 May 21 Jul21 Sep 21 Mov 21
Feb 21 Apr21 Jun 21 Aug 21 Oct21 Dec1-15 21

Expense Summary [ 54000 - Job Expenses 48.90%

January 1through December 15, 2021 LBl 52700 - Payroll Expenses 35.50

62100 - Insurance 5.95

M 50100 - Cost of Goods Sold 4.37)

M 60100 - Automobile 2.02

M 64800 - Tools and Machinery 0.83

65100 - Utilities 0.62

M 62400 - Interest Expense 0.58

M 54200 - Repairs 0.50

M 63300 - Printing and Reproduction 0.43

W Other 0.14

Total §338162.41

By Account

Show on Pie Chart: | Income Expense

2. QuickBooks can display information on only 10 pie segments at a time. To display more
accounts, click the Next Group button at the top of the graph window.

3. You can change the date range by clicking on the Dates button at the top.
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]

o Step-by-Step: Display Income Accounts Instead of Expense Accounts

1. Click Income at the bottom of the graph window.

2. Choose to filter By Account, By Customer or By Class from the report tool bar.

Quicklnsight: Income and Expense Graph

Dates... By Account | By Customer By Class Next Group Print... Refresh

Income and Expense by Month
January 1 through December 15, 2021

5in 1,000%s
40
30
20
10
Jan 21 Mar 21 May 21 Jul 21 Sep 21 Mov 21
Feb21 Apr21 Jun 21 Aug 21 Oct21 Dec1-15,21

Income Summary W Sage, Robert £29%

January 1 through December 15, 2021 W Rahn Jennifer 5.80

Tony's Barber Shop 578

M Carr's Pie Shop 543

M Allard, Robert 540

M Davies, Aaron 531

Mackey's Mursery and Garden Supply 5.06

W Campbell, Heather 506

M Larsen's Pet Shop 506

W Samuels Art Supplies 5.06

W Other 4572

Total 5274,450.01

By Customer

Show on Pie Chart | Income  Expense

NOTES
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Use QuickZoom with Graphs

To help you better understand the information shown in the graphs, QuickBooks lets you trace
graphical data using QuickZoom. This works the same as the QuickZoom functionality on report
entries described earlier in this lesson.

@
o  Step-by-Step: QuickZoom on Graphical Information

1. Position the mouse pointer over the section of the chart you wish to see in more detail and
double-click.

= IMPORTANT: The QuickZoom report features will vary depending on the type of information you are
choosing to QuickZoom in order to get more details.

B QuickZoom Graph - 0O %
Hext Group Print...

Income Summary W Babcocks MusicShop  4.57%

January 1through December 15, 2021 B Cook, Brian 337

Pretell Real Estate 333

W Teschner, Anton 276

M Natiello, Ernesto 275

M Melton, Johnny 263

Memeo, Jeanette 1.99

M Mguyen, Tuan 177

M Baker, Chris 1.71

M Morgenthaler, Jenny 1.61

W Other 19.22

Sub-Total 5125480 47

By Customer
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Customize How Graphs Display

You can customize graphs to control what data they include and how the data is displayed. In this
exercise you'll change the display from three-dimensional (3D) to two-dimensional (2D) graphs.

@
o  Step-by-Step: Change from 3D to 2D

1. From the Edit menu, choose Preferences.
2. Inthe left panel, click Reports & Graphs.

3. Inthe My Preferences tab, place a checkmark in the box next to Draw graphs in 2D (faster).

Preferences *®

E?;r Accounting A My Preferences Company Preferences m
B sis
. ) ) - Cancel
E Calendar ] Prompt me to modify report options before opening a report
Hel
EZ chscking REPORTS AND GRAPHS GRAPHS ONLY —
Desktop View When a repart or a graph needs to be [+ Draw graphs in 2D (faster) Default
Finance Charge refreshed: [[] Use patterns
ﬁ‘ General 3 Prampt me to refresh Also See:
:i Integrated Applications @ Refresh automatically G |
) Dontrefresh enera
o i
& tems & Inventory
. Click Help for information about
% Jobs & Estimates refreshing a large report.
% Multiple Currencies
% Payments
B, Payroll & Employees
@ Reminders
m Sales & Customers
g@ Sales Tax
p Search
[3 Send Forms
% Service Connection
Spelling
4. Click OK.
5. Click Report Center.
6. Choose Sales then Sales Graph to view the effect of the change.
7. Click the Run (Display Report) icon.
8. Close the graph.
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9. Close the Report Center.

NOTES
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Analyze Financial Data - Review Questions

1. is the tool that allows you to drill down on summary reports and
graphs in QuickBooks.

2. When can you generate a QuickReport?
a. Only when viewing an active customer or account
b. Only when viewing a list, register or form
c. Only atthe end of the current fiscal period
d. Only when viewing balance sheet accounts
3. In which report category would you find a list of open invoices?
a. Company & Financial
b. Sales
c. Customers & Receivables
d. List

4. Report let you set custom criteria for the transactions you want to
include in a report.

5. Once you've customized a preset report to meet your needs, how can you save your settings so
you don't have to customize the report each time you run it?

a. Choose Save Settings from the Report menu
b. Choose Save Setting from the File menu

c. Click Memorize on the button bar

d. Click Modify then choose Memorize

6. True or false: Once you've exported report data to Excel, you can send modified data back to
QuickBooks.

a. True .
Call or Email us for Correct Answers
b. False
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Review Activities

1. Create a QuickReport on a name in one of Rock Castle Construction’s lists.

2. Rock Castle Construction wants to create a report that shows how much they have spent on
lumber for projects during November of the current year (the current year is whatever Rock
Castle Construction specifies is the current year based on the date you see when you open that
sample company). Create an item summary purchase report covering the date range for
November of the current year. Filter the report to show only Rock Castle Construction’s
purchases for lumber.

3. Batch process the balance sheet, profit and loss statement, and statement of cash flows using the
Process Multiple Reports window.

4. Use the Report Center to find reports that show the following:

® Sick and vacation balances for each employee
Time spent on each job
Inventory stock on hand and reorder point

Customers with overdue payments, how much they owe and their phone numbers

How much of total sales is taxable, at what rate, and how much sales tax is currently due
to be paid

ARDENT%
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